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1 Introduction 

This manual describes the universal data import and export method developed for Compano Online 

Software. 

1.1 Concepts 

COS 

Compano Online Software. 

 

Entity 

Data object in COS, for instance Product, Item, Assortment, Attachment, Price, etc. 

 

Record 

One instance of a data object in COS, for instance Product 23452-3. 

 

Import 

Import of data into data fields in COS. The data source is often an Excel or text-formatted file. Another way 

of importing data is accomplished by use of a (international) data exchange standard, such as DICO 

(INSBOU/SALES), BMEcat, FAB-DIS, etc. 

 

Export 

Export of data out of data fields in COS. The export is often an Excel or text-formatted file. Another way of 

exporting data is accomplished by use of a (international) data exchange standard, such as DICO 

(INSBOU/SALES), BMEcat, FAB-DIS, etc. 

 

Standard exchange format 

Several standard formats have been defined to exchange data for the construction and engineering sector, 

for example: PAB, DICO/SALES, BMEcat, FAB-DIS, et. cetera. These Data Exchange Standards facilitate 

the sharing of structured data across different information systems. 

 

Excel Update 

Method for updating data in COS, using the Internet Explorer 11 browser and the MS Office Add-In. This 

method is no longer in use as of COS version L03. 

 

Screen layout 

Layout of data columns (fields) on an Overview in COS. Layouts can be customized by the user and often 

serve as a mapping for data exports as well. 

 

Export layout 

Layout for exporting data out of COS. Export layouts can be customized by the user, or are generated on-

the-fly. 

 

 

 

Delta import 

A Delta Import compares data in the source file with data in COS. On import only any new or changed data 

is imported. 

 

Full import 

A Full Import compares data in the source file with data in COS. On import any records in COS which are not 

offered in the import file, will be Archived. All data in COS is overwritten with data from the import file. 
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Multi-pass import 

Consecutive import of multiple entities from one data file. Up to 5 consecutive imports can be handled. 

1.2 Automated imports 

Besides the universal import and export method, import and exports can also be automated. For instance, a 

data file for import can be transferred to the Compano server via FTPS to a standard import folder, from 

where it is automatically processed. 

 

Options for automated import and export are: 

 

• Automated import of industry standard formats: See the manual COS Basics. 

• Automated import or export non-standard (custom) formats: See the manual Periodic Tasks. 

 

Note: For automated imports and exports, an extra FTPS user account needs to be added. Please contact 

sales@compano.com for information on options and pricing. 

2 Export 

To tackle all export scenario’s, a universal export method was developed. This new method will handle: 

 

• Custom exports: used for Excel, CSV, Unicode and fixed width exports 

• Update exports: used for updating data in COS 

 

For exporting of Assortments and Items in a standard exchange format, an standard item export is 

available: 

 

• Standard export: used for exporting item information using standard exchange formats, such as 
INSBOU, BMEcat, FAB-DIS, etc. or other custom formats (Pricat, Galvano, etc.). 

2.1 Industry standard export 

The Item export function can be used for exporting Items or Assortments1 in the following industry standard 

data exchange formats. 

 

Note: For detailed information on Industry standard exports, please see the manual COS Basics. 

 

With a standard Compano license: 

 

• PAB2.0: ASCII* Product Data & Article (PAB) 

• PAB2.03: ASCII* Product Data & Article (PAB) 

• SalesBouw: Older format for Building sector only 

• DICO/INSBOU003: UTF-8 XML-based compressed format 

• DICO/INSBOU004: UTF-8 XML-based compressed format, with language selection 

• DICO/SALES005: UTF-8 XML-based compressed format, with language selection and including 

certificates 

In addition, the following export formats are available with a Compano International licence: 

 
1 Depending on the export format, these exports can be set to also include product, attachment, accessory, and other 
information. 

mailto:sales@compano.com
https://help.compano.nl/compano-manuals/Manuals-l.html?style=L06#general
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• BMEcat 4.2: BMEcat 2005 ETIM Guideline Version 4.0.2 

• BMEcat 5.0: BMEcat 2005 ETIM Guideline Version 5.0 

• Datanorm 4.0: Open standard for plumbing, heating, electrical and painting and varnishing 

industries 

• IGH: Data exchange format used in Switzerland 

• DQR: Data export format according to the Datenqualitätsrichtlinie (DQR) for ARGE, BVBS, DG 

Haustechnik and ZVSHK. Data can be exported according to the following guidelines: 

o DQR 9.0 (OpenData/ITEK) 

o DQR 9.0 (ARGE) 

o DQR 8.0 (OpenData) 

• FAB-DIS 2.3: Data exchange format based on the BMEcat®-Standard and managed by ETIM 

International, which is used in France 

• FAB-DIS 3.0: Data exchange format based on the BMEcat®-Standard and managed by ETIM 

International, which is used in France 

• ETIMxChange: Exchange format for ETIM data in JSON format; successor to the BMEcat standard. 

Furthermore, items or assortments can be exported in formats compatible with the following software 

packages: 

 

• Compano: GA-Software 

• Compano: InstallCalc 

• Building Infosys: Install Office (t/m K40.14.008) 

• Building Infosys: Install Office (from K40.14.009) 

• Acto: Easy Project/MyProject 

• InstalLogic: Handsoft 

• Syntess: Atrium/Prisma 

• ENK Software: ENK ERP-software 

 

Should you choose to export data using one of the industry exchange formats, you have the option to either 

export all items of an assortment, or export (a selection of) items directly. 

 

Note: For a correct export in the x format, some additional steps need to be performed; these are described 

in the manuals for these export formats. 

 

Warning: Please pay close attention to your settings when switching between export formats! Settings in the 

export dialog below are stored per user, however common settings are retained when selecting a different 

export format. Thus, for instance, when exporting in the FAB-DIS format with the ETIM 8 setting, this setting 

is retained when switching back to the DQR export format.  

2.2 Custom export 

For other export scenario’s, custom export layouts are used: 

 

• Custom screen layouts 
o Layouts for exporting an Excel file based on the screen layout 

• Custom export layouts 
o Layouts for exporting an Excel file 
o Layouts for exporting a text-based file (CSV, Unicode) 

 

Note: Custom export layouts can be created in advance, or generated on the fly. 

2.2.1 Export with custom screen layout 

On any Overview the screen layout can be used to export data. All data which is visible in the Overview will 

be exported as an Excel file. 

https://help.compano.nl/compano-manuals/Manuals-l.html?style=L06#export
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To export data using the screen layout: 

 
1. Through the Menu, navigate to the relevant Overview, for instance Products. 
2. Go to the View tab and select the screen layout which contains the data fields that you need to 

export, for instance: 

 
Note: Detailed information on how to create screen layouts can be found in the Basic Manual 

Compano Online Software. 

 
3. Optionally, use Filter and Search to find a set of records. 
4. Use select All (CRTL-A) or manually select records that you need to export. 
5. Next, go to the Import/Export tab and click on Export [ENTITY]: 

 
6. In the Export [ENTITY] dialog: 
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a. Use screen layout: Set to Yes. 
b. Prepare for import (optional): Set to Yes ,when you need to use the resulting export for 

later importing of (updated) data. 

Note: This option replaces the Excel Update function of COS-versions L02 and older. Also 

see paragraph 2.3 Update export (ExcelForImport). 

c. Summary: Lists the records and data fields to be exported. 
7. Click on Export and save the file at a location of your choice. 

2.2.2 Export with custom layout (Excel) 

Custom export layouts offer more options for data exports than screen layouts. Some options are: 

 

• Conversion of data: for instance, conversion of units (PCE to STUK). 

• Insert header (Yes/No): Insert a header row containing data labels. 

• Export type2 (product exports only): Choose an export layout type: 

 

 
2 Note: Other dedicated export types can be added on request, for instance for memos, attachments, et cetera. 
Please contact sales@compano.com for more information. 

mailto:sales@compano.com
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o Standard: Standard export layout, also suitable for updating data. 
o Include product classes: Export layout suitable for updating (ETIM) product data; will 

export the product class(es) and their features. 
o Include model classes: Export layout suitable for updating (ETIM MC) model data; will 

export the model class(es) and their features. 

 

Note: Also see paragraphs 2.3 UPDATE EXPORT (EXCELFORIMPORT) and 3.3 UPDATE IMPORT 

(EXCELFORIMPORT) for a complete description of the update procedure. 

 

To export data using an Export layout: 

 
1. Through the Menu, go to the Overview where you want to Export data. 
2. Use Filter and Search to find a data set. 
3. Use select All (CRTL-A) or manually select records that you need to export. 
4. Next, go to the Import/Export tab and click on Export [ENTITY]: 

 
5. In the Export [ENTITY] dialog: 

 
a. Use screen layout: Set to No. 

b. Export layout: Use the +-icon to create a new layout3. Alternatively, choose an Export 

layout from the drop-down menu4. Note: Export layouts can also be prepared at System > 
Layouts; see chapter 4. Layout management. 

 
3 This method only allows for creation of Excel export layouts. If you need to export in a text-based format (CSV, 
Unicode), the export layout will have to be created through System > Layouts, see: 4.1.1 Add custom text-based 
export layout. 
4 Export layouts created for any Entity, either on-the-fly or at System > Layouts will show up in the drop-down menu 
of the Entity. 
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c. Prepare for import: Set to Yes, when you need to use the resulting export for later 
importing of (updated) data. Note: This option replaces the Excel Update function of COS-
versions L02 and older. Also see paragraph 3.3 Update import (ExcelForImport). 

 

Add New Layout 
(skip if you selected a premade layout) 

 

In the Add – New layout dialog: 

 

Layout tab 

 
a. Name: Enter a Name for the Export layout. 
b. Application: Set to For me if the layout is for your own use only, or to Within 

the company if all users within your company need to have access to this 
layout. 

 

Properties tab 

 
a. Insert header: Set to Yes to include a header row containing data field labels in 

the export file. 
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Fields tab 

 
a. Available fields: Fields which can be added to your layout. 
b. Selected fields: Selected fields which will exported. 

> and <: Use these buttons to either add to or remove fields from the 

Selected fields. 

 

Next, click on Save record to save your layout5. After saving the export layout, you 

will return to the Export dialog. 

 

 
6. Click on the Export button to start the export process: 

 

 
5 Important: export layouts are created for one specific Data Entity only, for instance when creating an export 

layout from the Product overview the layout will be limited to exporting records of the entity Product only. 
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Depending upon your browser download settings: 

 
a. The resulting Excel file will be exported to the Download folder of your browser: 

 
b. Or you can download the Excel file to a folder of your choosing: 

 
 

The resulting Excel file, named COS-Excel-[ENTITY]-[DATE]-[TIME]6.xlsx, will contain all data fields 

which were specified in the Export layout: 

 

2.2.3 Export with custom layout (text-based) 

Important: A custom text-based layout cannot be created on the fly. Prepare your text-based layout at 

System > Layouts, also see paragraph 4.1.1 ADD CUSTOM TEXT-BASED EXPORT LAYOUT. 

 

To export data with a custom text-based layout: 

 
1. Through the Menu, go to the Overview where you want to Export data. 
2. Use Filter and Search to find a data set. 
3. Use select All (CRTL-A) or manually select records that you need to export. 
4. Next, go to the Import/Export tab and click on Export [ENTITY]: 

 
6 [DATE] en [TIME] reflect the data and time of the export. 
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5. In the Export [ENTITY] dialog: 

 
a. Use screen layout: Set to No. 
b. Export layout: Choose the text-based layout from the drop-down menu. 
c. Compress (optional): Set to Yes, should you need to lower the file size of your export. The 

file will be export in the ZIP compression format. 

2.3 Update export (ExcelForImport) 

Any Excel export layout can be used to create an ExcelForImport-file, by setting the Prepare for import 

option to Yes: 

 
The resulting Excel file will be named COS-ExcelForImport-[ENTITY]-[DATE]-[TIME].xlsx 

Important: When renaming an ExcelForImport file, always make sure the filename starts with 
COS-ExcelForImport, otherwise the update import will not work properly. 
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To update data, edit this ExcelForImport-file with Microsoft Excel. Subsequently, use the Import function in 

COS to import the updated data, see paragraph 3.3 UPDATE IMPORT (EXCELFORIMPORT). 

 

Important: Worksheets in an ExcelForImport file are protected; should you remove this protection, then 

Compano cannot guarantee that any changes in the file will be imported correctly. 

 

Note: The ExcelForImport-option replaces the Excel Update function of COS-versions L02 and older. 

2.3.1 Removing Excel protection 

Removing the protection of ExcelForImport worksheets is not recommended. However, should you wish to 

do so, a few rules apply: 

 

• Hiding columns/rows: Data in hidden columns and/or rows will be imported. 

• Removing/Adding columns/rows: Not allowed; you can no longer import the ExcelForImport file. 

• Filtering/Sorting data: Using filters or sorting in Excel is allowed. Note: When importing an 
ExcelForImport file with active filters, all data in the file will be imported, including any data that has 
been filtered out (!) 

• Editing greyed-out data: Not allowed; by importing grey-out data you will mess up your data in 
COS. 

• Using formulas: Formulas in existing columns are allowed, however you cannot refer to data in 
added columns, worksheets or other (Excel) files. 

• Changing cell formats: Not allowed; you can no longer import the ExcelForImport file. 

2.3.2 Non-editable fields 

Data fields in Compano that cannot be updated directly are marked-out in grey in both the COS field selector 

and any exported Excel files: 

 
Figure 1. Non-editable fields in the field selector 
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Figure 2. Non-editable fields in the exported Excel file 

Non-editable fields include: 

 

• Reference(data) fields: These fields cannot be updated directly, because their value comes from 
another data field in Compano. For instance, Translatable fields where the value of the field refers to 
one or more corresponding language-specific fields: Short Description can refer to Short 
Description (nl), but also to Short Description (en) 

• Calculated fields: The value of the field is calculated from one or more other data fields in the 
application. For example: the Net price is calculated from Gross price minus Discount. 

• Read-only fields: Some fields in COS are read-only and never be updated. Examples are: Import 
date, Author, etc. 

2.3.2.1 Updating calculated fields 

For calculated fields, the value of the field is calculated from one or more other data fields in the application. 

Therefore, to update the value of a calculated field, these ‘source’ fields need to present in your Excel export 

layout. 

 

Example 

The value of Net price is calculated from Gross price minus Discount. To edit the Net price, either the 

Gross price or the Discount, or both need to be present in your layout: 

2.3.2.2 Updating translatable fields (multi-language license only) 

In COS-applications with a multi-language license, translatable fields refer to their language-specific 

counterpart(s), based on the language that is set for your user-interface, for example: 

 

 User-interface language 

Translatable field English (en) German (de) 

Series → refers to: Series (en) Series (de) 

Type →refers to: Type (en) Type (de) 

 

Thus, to update the value of a translatable field, you should really update the corresponding language-

specific field. 

 

Example 

Suppose you need to translate the fields Series and Type on the entity Product and the language of your 

user interface is English (en). In this case the fields Series and Type refer to Series (en) and Type (en). Only 

the latter two fields can be edited using the Universal Import/Export method: 

 
1. Through the Menu, go to Products > Products. 
2. On the Products overview, go to the View tab and click on Manage screen layouts: 
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3. Under Edit, click on +Add to create a new screen layout: 

 
4. On the Layout tab, name your layout: 

 
5. Next, on the Fields tab, add the Translation fields. 

 

Note: Translation fields can be found under Available fields > By category > Product > Translations > 

Translations English: 
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Reminder: The default fields Series and Type (crossed-out) cannot be updated as they take their 

content from the language-specific fields of your user interface, in this example their English (en) 

counterparts. 

 
6. Apply the screen layout. 

 

After exporting the product data, the resultant ExcelForImport-file will clearly show the difference between 

the non-editable default data fields (greyed-out) and the editable language-specific data fields (black): 
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2.3.3 Mandatory key fields 

Specific key data fields are required to import each entity. These fields are included when using the Prepare 

for Import option, however on custom imports these fields will need to be present in your import layout and 

import data file. 

 

Mandatory fields are marked in red in the New layout dialog: 

 

Important: When migrating to COS version L03, existing import (and export) layouts 
should be checked for missing mandatory fields. For an overview of the mandatory key 
fields per data entity, see chapter 5 APPENDIX A: . 

2.3.4 Export classification fields 

Updating of product classification data (ETIM or BIM) can be accomplished using two dedicated Export 

types: 

 

• Include product classes: used for updating ETIM product classification data 

• Include model classes: used for updating BIM-model classification data 

 
For a further explanation, see paragraph 3.3.1 UPDATING CLASSIFICATION DATA 
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2.3.5 Exporting fields containing HTML 

Certain data fields in COS can contain HTML formatting code, for instance the Commercial Description field. 

When exporting these data fields, please note: 

 

• Custom export: The HTML-code is stripped on export; the export file will contain no HTML-codes. 

• Export for import: The HTML-code is exported; the ExportForImport-file will contain HTML-codes, 
which can be updated and imported back into COS. 

3 Import 

To tackle all import scenario’s, a universal import method has been developed. This new method will 

handle: 

 

• Standard imports: used for importing data by means of industry standards, such as DICO 
(INSBOU/SALES), BMEcat, FAB-DIS, etc. and custom formats, such as Pricat, Galvano, et cetera. 

• Custom imports: used for importing character-separated and fixed-width data files, such as Excel, 
CSV, and TXT (Unicode). Note: can also be used to import Excel files with multiple worksheets or 
compressed files (ZIP, BZIP) containing multiple data files. 

• Update imports: used for updating data. This option replaces the Excel Update function. 

 

Some general notes on importing data: 

• A data import can be started on any Overview using the Import button. The application will 
autodetect which kind of data you wish the import. If this is unclear, the import dialog will ask for the 
import Entities and any import layouts for your data. 

Tip: For ease of use, when importing data of a single Entity, Compano recommends 
using the Import button on the corresponding Overview of the Entity; for instance 
product data at Products, surcharges at Surcharges, et cetera. 

• Column headers in the import file need not reflect corresponding header labels in COS; therefore you 
are allowed to change the labels of any column headers in your import files or ExportForImport files. 
Note: The Pos(ition) number of the data field must correspond with the correct Excel data column! 

• To prevent overwriting data, a custom import layout can be defined where overwriting data can be 
disabled per data field: 
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3.1 Industry standard import 

An industry standard import can be used with the following data exchange formats: 

 

• IXF (classification XML) 

• ICC (conditions XML) 

• PAB105 

• PAB20 

• PAB203 

• PRICAT (PrIce / Sales catalog) 

• SALESBOUWV3 

• INSBOU003 

• INSBOU004 

• DICO/SALES005 

• DICO/SALES0051 

• EZBASE 

• BMEcat31 

• BMEcat42 

• BMEcat50 

• DataNorm 

• DataNormV12Xml 

• DQR8 (OpenData, ARGE) 

• DQR9 (OpenData, ARGE)7 

Note: The Import function will autodetect which industry standard exchange format is offered. 

 

 

 
7 DQR 9.0 is under development as of 24-4-2023 
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Warning: For industry standard imports, such as SALES005, DQR, BMEcat5, if the import 
is recognized (especially for the items) as a full import and there are no errors, then any 
previously imported and untouched articles will be archived. Thus, if items were added 
manually, they will not have an import date and therefore they will not be archived. 

To import data using a industry standard exchange format (DICO/SALES005 example): 

 
1. To start the import of data, through the Menu, go to Items > Assortments: 

 
2.  Next, go to the Import/Export tab and click on Import: 

 
3. In the Import dialog, first select your data file and click on Next: 

 
 Important: The data file will be analysed upon import; depending upon the size of the data file, this 

can take some time. Please be patient. 

 
4. In the Import dialog : 
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a. Reporting level: Select the reporting level for the import report: 

i. None: Do not generate an import report. This will result in the fastest import. 
ii. All except the product class features: Generate an import report, but exclude any 

checks on (ETIM) Product Features. This is the default setting for all imports and 
will result in a faster import. 

iii. Full: Generate a full import report, including all changes in all fields. This will result 
in the slowest import as all data fields will be checked. 

iv. Only warnings: Generate an import report only listing warnings. This import is 
generally faster than with a Full report. 

b. Is testrun: Set to Yes to simulate an import; this will only generate an import report listing 
any potential errors and/or warnings. No data is actually imported! 

c. Selected files8: Several entities can be selected for delta or full import, for instance: a delta 
import of products, a full import of items, a delta import of product attachments, etc. Use the 
checkboxes to (de-)select which data is to be imported, in this example: 

i. Delta import of products: Check this box if you need to import only changes in the 
product data (new or changed products). When set to No, the data will not be 
imported. 

ii. Delta import of etim product features: Check this box if you need to import only 
changes in the ETIM product data (new or changed ETIM classes and/or features). 
When set to No, the changed ETIM data will not be imported. 

iii. Delta import of attachments (products): Check this box if you need to import only 
changes in the attachment data (new or changed attachments). When set to No, the 
data will not be imported. 

iv. Full import of items: Check box if you need to import all (new) item information. 
When set to No, the data will not be imported. 

 
8 Which Selected files will show, depends on the type of import file offered. 
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v. Delta import of attachments (items): Check box if you need to import only 
changes in the attachment data (new or changed attachments). When set to No, the 
data will not be imported. 

5. Click on Next to start the import; you will receive the following pop-up message: 

 
You will receive an import report via e-mail9, or you can find the import report under System > Logs. See 

also paragraph 3.5 IMPACT ANALYSIS. 

3.1.1 Automatic import 

For Industry standard data files, an import can be set up: 

 

• Compano customer sets up an automated upload of an industry standard data file to a Compano 
FTPS-server location. 

• COS software automatically imports the data file as a nightly job. 

 

For more information, see chapter 7 APPENDIX C: AUTOIMPORT/AUTOCHECK and contact Compano 

consultant. 

3.1.2 DQR import 

For DQR imports, the following applies: 

 

• Supported DQR import formats: DQR 8.0 and DQR 9.0 

• ETIM version: Should a DQR file contain multiple ETIM versions, on import only the most recent 
ETIM version will be imported. 

3.1.3 FAB-DIS import 

FAB-DIS is an Excel format and can thus be imported using a custom Excel import, with the exception of 

ETIM-classification data which cannot be imported this way. 

3.2 Custom import 

Custom import files, such as Excel, CSV or (Unicode-) Text files, need to be imported using custom import 

layouts. 

 
9 For automated import tasks (periodic tasks), the import report is sent to the admin user. 
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Custom import layouts can be created: 

 

• On-the-fly: In the Import dialog, see the numbered list below. 

• At System > Layouts: See paragraph 4.2 ADD IMPORT LAYOUT. 

 

To import a custom data file: 

 
1. Through the menu, go to the Entity10 that you need to import, for instance Items > Surcharges: 

 
2. Next, go to the tab Import/Export and click on Import: 

 
3. In the Import dialog, first select your import file and click on Next: 

 
4. In the next screen: 

 
10 Or, use any Import button in COS. 
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Layout111 

a. Summary: The Summary lists all fields which are to be imported, based on the selected 
Import layout. 

b. Title: Name of the import source; for instance, the name of the Excel worksheet. 
c. Import entity: Autodetected import entity; if this is not correct, select a different entity from 

the drop-down menu. 
d. Import layout: Either select a premade Import layout from the drop-down menu, or click on 

the +-icon to create an Import layout on-the-fly. 

  

 
11 In case of multiple data sources, for instance an Excel file with multiple worksheets, the dialog will list a layout for 
each data source (Layout1, Layout2, Layout3, etc.). 
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Add New Layout 

(skip if you selected a pre-made layout) 

 

In the Add – New layout dialog: 

 

Layout tab 

 
a. Name: Enter a Name for the Import layout. 
b. Application: Set to For me if the layout is for your own use only, or to Within the 

company if all users within your company need to have access to this layout. 

 

Properties tab 

 
a. Number of header rows: Enter the number of header rows in your Excel file that should 

be skipped on import. 
b. Continue import on errors: Set to Yes, if the import should continue when 

encountering a faulty record. 

 

Fields tab 
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a. Available fields: Fields which can be added to your layout. 
b. Selected fields: Selected fields which will exported. 

> and <: Use these buttons to either add to or remove fields from the Selected fields. 

 

Next, click on Save record to save your layout12. After saving the export layout, you will return to 

the Import dialog. 

 
5. Click on Next to go to the Import settings: 

 

 
a. Reporting level: Select the reporting level for the import report: 

i. None: Do not generate an import report. This will result in the fastest import. 
ii. All except the product class features: Generate an import report, but exclude any 

checks on (ETIM) Product Features. This is the default setting for all imports and 
will result in a faster import. 

iii. Full: Generate a full import report, including all changes in all fields. This will result 
in the slowest import as all data fields will be checked. 

 
12 Important: Import layouts are created for one specific Data Entity only, for instance when creating an 

import layout for the Product overview the layout will be limited to importing records of the entity Product 

only. 
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iv. Only warnings: Generate an import report only listing warnings. This import is 
generally faster than with a Full report. 

b. Only warnings: Generate an import report only listing warnings. This import is generally 
faster than with a Full report. 

c. Is testrun: Set to Yes to simulate an import; this will only generate an import report listing 
any potential errors and/or warnings. No data is actually imported! 

d. Fill conversion list: Set this option to Yes, if you need to fill any Conversion lists that you 
have created; see also paragraph 3.2.3 ARCHIVE / Restore records 

e. The Archive Status of a record can also be changed using an import file. The import file 
should contain a data column labelled Archived, where the archive status can either be set 
to Yes (record is archived) or No (record is not archived): 

 
Archive products/items on import 

For the import of Products and Items only, an alternative archiving option is available: 

 

In the Import dialog the option Archive not imported records can be set to Yes. Any Products (or Items) 

which are present in the COS database, but are no longer offered as a record in the Import file (Excel or 

text-based), will then be archived. 

 

Important: The Archive not imported records option will only be available when an Import layout is 

selected that contains the key data fields for the entities Product or Item. 

 

Note: Not imported records will only be archived when the import report contains no errors (!) 

 
Note: Archiving of products/items using the Archive not imported records will also function when the layout 

is used for a Periodic Import Task. 
f. Conversion table 

6. Click on Next to start the import; you will receive the following pop-up message: 
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3.2.1 Multiple data sources 

The Universal import method also provides for importing multiple data source at once. The following 
data files can contain multiple data sources: 
 

• Multiple worksheets (Excel): An Excel file with multiple data worksheets. 

• Compressed file (ZIP, BZIP): Compressed format containing multiple text data files. Important: 
The compressed file can only contain data files in text-format (CSV or Unicode). 

 
Note: Each data source needs to be linked to an Entity and imported with a separate import layout. 
 

On import, an Entity and Layout need to be assigned to each data source, as demonstrated below: 

 
To import multiple data sheets or files: 
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1. Through the Menu go to any data entity, for instance Products: 

 
2. Go to the Import/Export tab and click on Import: 

 
3. In the pop-up window, select your multiple data file, and click on Next: 

 
4. In the next window, you will be presented with one or more data Layouts. If your import file contains 

multiple text data files or Excel worksheets, these are automatically detected and named Layout1, 

Layout2, etc.: 
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For each Layout: 

a. Import entity:  Select an Import entity.  
b. Import layout: Select an Import layout, or—alternatively—, add a create an import layout 

using the +-buttons. 

 

Note: Optionally skip importing of a data Layout by not selecting an Import entity and/or 

Import lay-out. 

 
5. Click on Next for the Import settings: 

 
a. Reporting level: Select the reporting level for the import report: 

i. None: Do not generate an import report. This will result in the fastest import. 
ii. Full: Generate a full import report, including all changes in all fields. This will result 

in the slowest import as all fields will be checked. 
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iii. Only warnings: Generate an import report only listing warnings. This import is 
generally faster than with a Full report. 

b. Is testrun: Set to Yes to simulate an import; this will only generate an import report listing 
any potential error and/or warnings. No data is actually imported! 

c. Selected files: (De-)select the files from your multiple data set which you need to import. 
6. Click on Next to start the import. You will receive an e-mail with an Import report. 

3.2.2 Multi-pass import 

A multi-pass import allows for multiple, consecutive imports of data with different import layouts. This method 

can be used for: 

 

• Import of interdependent data sources, such as: 
o Product and Item 
o Item and multiple Attachments 
o Item with Current and Future Price 

• Import of column-based data sources, such as Items with different Packaging data, ordered in 
consecutive Excel columns. 

• One Periodic Task instead of multiple, interdependent periodic tasks, for example, for importing 
product and item data. 

 

Important: A maximum of 5 consecutive imports can be handled this way. 

 

Note: Multi-pass imports can make use of Excel or CSV data files, provided the correct type of import layout 

is selected. 

 

For detailed instructions, see the Manual Periodic Tasks, which is available on the Compano Help website. 

 

Multi-pass imports need to be prepared and tested: 

 

• First, set up and test the import of the main entity; for instance Product data. 

• Next, set up and test the import of the subsequent data/entity; for instance Item data. 
o Optionally, repeat this step for the remainder of the subsequent data/entity imports. 

• Create the multi-pass import by linking the main and subsequent import(s). 

 

Example 

To set-up a multi-pass import, for example to import Product and related Item information: 

 
1. First, prepare the import layout for the main entity, which is Product data in this example. 

 

Note: Detailed information on how to add an import layout, can be found in paragraph 4.2 ADD 

IMPORT LAYOUT. 

 
2. Use the import layout and your data file to test the import; see PARAGRAPH 3.2 CUSTOM IMPORT for 

detailed instructions. 
3. Next, prepare the import layout for the subsequent data/entity, which is Item data in this example. 
4. Use the import layout and your data file to test the import; see PARAGRAPH 3.2 CUSTOM IMPORT for 

detailed instructions. 
5. Now, go to System > Layouts: 

https://help.compano.nl/compano-manuals/Manuals-l.htm
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6. Select the import layout of your main entity and, under Edit, click on Modify: 

 
7. In the pop-up window, on the Properties tab: 

 
a. Next import layout: Select the import lay-out for the subsequent data/entity import. 

8. Save the record. 
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3.2.3 Archive / Restore records 

The Archive Status of a record can also be changed using an import file. The import file should contain a 

data column labelled Archived, where the archive status can either be set to Yes (record is archived) or No 

(record is not archived): 

 

3.2.3.1 Archive products/items on import 

For the import of Products and Items only, an alternative archiving option is available: 

 

In the Import dialog the option Archive not imported records can be set to Yes. Any Products (or Items) 

which are present in the COS database, but are no longer offered as a record in the Import file (Excel or 

text-based), will then be archived. 

 

Important: The Archive not imported records option will only be available when an Import layout is 

selected that contains the key data fields for the entities Product or Item. 

 

Note: Not imported records will only be archived when the import report contains no errors (!) 

 
Note: Archiving of products/items using the Archive not imported records will also function when the layout 

is used for a Periodic Import Task. 

3.2.4 Conversion table 

For some data fields, you can define a conversion table. This is useful if your import file contains non-

standard values for the data field in question. For instance, for the field Packing Form a conversion table 

can, on import, convert the value PALLET to code 09 for Returnable pallet. 
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Note: Not all data fields have the conversion list option. 

 

To add a conversion table: 

 

1. At the field with the Conversion table option, click on the +-icon: 

 
2. In the pop-up window: 

 
a. Code: Enter a code for the Conversion table 
b. Description: Enter a description for the Conversion table 
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c. Conversion object: Name of the object (auto-filled) 
d. Use: Table is used for either imports or exports. 
e. Missing conversion line: If the value is missing in the conversion table, write the value of 

this field into COS. If left empty, the original value from the (import) file is written. 
f. When empty input: If there is no value for this field in the (import) file, write the value of this 

field into COS. If left empty, no value is written. 
3. Save the conversion table. 

 

Once the Conversion Table has been created, you have to option to either: 

 

• Manually fill the conversion table at Configuration > Conversion tables, or 

• Automatically fill the conversion table, by setting the Fill conversion list option at import. 

3.2.4.1 Manually fill conversion table 

To manually fill the conversion table: 

 
1. Through the Menu, go to Configuration > Conversion tables: 

 
2. In the Conversion Table overview, select the conversion table you need to fill and click on Lines: 

 
3. In the next screen, under Edit, click on +Add to add conversion lines: 
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4. In the pop-up windows: 

 
a. Conversion object: Name of the conversion object (auto-filled) 
b. Value in: Enter the value, such as encountered in your (import) file, which is to be 

converted. 
c. Value out: Enter the converted value, or choose a standard value from the drop-down list. 

5. Save the record. 

 

Note: Add as many conversion lines as are need to convert all different values in your (import) file. 

Alternatively, you have to option to automatically add a conversion line for all different values in your (import) 

file; see the next paragraph. 

3.2.4.2 Automatically fill conversion table 

To automatically fill the conversion table: 

 
1. Through the menu, go to the overview where you need to import data. 
2. Go to the tab Import/Export and click on Import. 
3. In the pop-up window, select an import file and click on Next. 
4. In the next dialog window, select an Import entity and Import layout, and click on Next. 
5. In the next dialog window, set the option Fill conversion list to Yes: 
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6. Click on Next to start the import. Note: No actual import will take place; only the Conversion list 

(table) will be filled. You will receive two e-mails, one analysis report concerning the added 
conversion values, and one import report stating that the import has finished without any changes: 

Figure 3. Conversion analysis report 

 
Figure 4. Import report 

7. Conversion lines have been added to your conversion table, however you will need to Modify each 
line to enter the Out values (see also 3.2.4.1 MANUALLY FILL CONVERSION TABLE): 
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3.2.5 Date fields 

Special care should be taken when importing dates. Date fields in Compano expect a true date-formatted 

value; when using an Excel file as your import file, make sure that Excel cells containing date values are of 

the correct cell format: Date. 

 
To avoid formatting when copying/pasting data from another source, make sure to paste your data in Excel 

using the Paste special option Paste value only: 
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3.2.6 Multi-select fields 

Values for multi-select data fields—such as Publication—where multiple options can be selected, can be 

imported using a comma as a separator between values: 

 
To import values for this data field, values should be separated with a comma: 

 

3.2.7 Fixed values 

For some fields in your layout, fixed values can be used. Two scenarios with fixed values are: 

 

• For all data records, the value is the same, fixed value. For instance, Price Unit 

• Wherever the value for the data field is empty in the import file, a fixed value should be written into 
COS. For instance, price data: 
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To add a value for a (mandatory) data field which is not present in your import file and which for all records 

should have the same value. 

 

For example, if in your import file the column Price Unit is not present and for all items the value of Price Unit 

should be 1, then you can add this as a fixed value: 

 
1. In the Add/Edit layout dialog, on the Fields tab, add the field Price unit (pu) code. 
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2. Under Selected fields, select the field you just added and, at Properties, uncheck the checkbox 
Automatic. 

3. Now, type the value 0 for Field position. Select a fixed value from the drop-down menu; in this case 

the value Piece (PCE). 

4. Save the layout. 

 

When importing item information, using this layout, all items will have the value PCE assigned to the value for 

their Price Unit. 

 

Important: With this method, the position of data in the import file can be set to 0, as no actual data will be 

read from the data file. 

3.2.8 Maintain values (do not overwrite) 

To prevent overwriting of data in COS on import, set the Maintain option of a data field to Yes: 

 

3.2.9 Continue on error 

By default, any imports are terminated when the import process encounters an error. Should the import 

continue on errors for a certain data field, then set the Continue on error option to Yes: 
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3.2.10 Concatenate (merge) descriptions 

Multiple data columns in an import file can be merged, on import, to yield a concatenated text value which 

will be entered into the Description or Short Description data field in COS. 

 

Note: This feature is available for text-based import formats, such as CSV and UNICODE and applies to the 

following data fields: 

• Product Description 

• Product Short Description 

• Item Description 

• Item Short Description 

 

Example CSV 

Item number;Assortment code;Text 1;Text 2 

2345;VX_NL;This is the first part;and this the second part of the description 

2346;VX_NL;This is the first part;and this the second part of the description 

2347;VX_NL;This is the first part;and this the second part of the description 

 

To concatenate Texts 1 and 2 on import, the following import lay-out can be made: 
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In the layout above, the data field Description has been added twice, such that data from column 3 and 4 of 

the CSV import file will be merged. 

 

Tip: By adding the data field Description a third time and setting a fixed value, a space character can be 

added between texts 1 and 2: 

 

3.2.11 Country-specific fields 

For country-specific fields of Item and Product, the Size Unit Code for Weight and Volume can added to the 

import layout thus enabling import of these values, including Imperial values. 



 

45 

 

3.3 Update import (ExcelForImport) 

The data in an ExcelForImport-file can be edited using Microsoft Excel: 

 
1. Open the exported Excel-file: 

 
2. When editing data in any cell, please note: 

a. Black font: Data field is editable and can also be empty 
b. Grey font The data cell is protected against editing. You cannot edit greyed-out data fields 
c. Red font: This data field is required; the cell cannot be empty (!) 

3. After editing, save the Excel-file. 

 

Important: The new Excel update import can no longer be used to add new records. 
 
Updated data from a saved Excel-file13, named COS-ExcelForImport-Items-[DATE]-[TIME].xlsx, can 

be imported back into the Compano application: 

 
1. Through the Menu go to the data that you need to import, for instance Product data. 
2. Go to the Import/Export tab and click on Import: 

 
3. In the pop-up window, select the Excel-file for import and click on Next: 

 
4. On the next screen: 

 
13 Important: When renaming the ExcelForImport file, always make sure the filename starts with: COS-

ExcelForImport. 
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a. Summary: Check which data fields will be imported. 
b. Reporting level: Select the reporting level for the import report: 

i. None: Do not generate an import report. This will result in the fastest import. 
ii. Full: Generate a full import report, including all changes in all fields. This will result 

in the slowest import as all fields will be checked. 
iii. Only warnings: Generate an import report only listing warnings. This import is 

generally faster than with a Full report. 
c. Is testrun: Set to Yes to simulate an import; this will only generate an import report listing 

any potential error and/or warnings. No data is actually imported! 
5. Click on Next to start the import and check your browser or default Download folder for the Import 

report14: 

 

3.3.1 Updating classification data 

Updating of product classification data can be done through dedicated export layouts for product and model 

classes. These layouts are available on the Product and Product Classification overviews and allow for: 

 

• Updating data for one or multiple product classes of a set of products 

• Drop-down selection of alphanumeric ETIM-feature values in the exported Excel-file 

 

Note: Only (ETIM) classification feature values can be updated this way. (ETIM) classes need to be assigned 

to products by Editing or Manipulation. 

 

More information on updating classification data can be found in the Manual Classification (L03). 

3.3.2 Updating archived records 

The update import can also be used to archive or unarchive records. 

 
14 Note: The import report is also available under Menu > System > Logs. 
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The following applies to all archived records: 

 

Archived status 

before import 

Update 

Archived 

status to 

Value updated on 

import? 

Archived status 

changed to 

Yes (archived) No update No - 

No (not archived) No update Yes - 

No (not archived) Yes Yes Yes 

Yes (archived) No Yes No 

 

The Archived status can be updated by adding the Archived data field to screen or export layout: 

 

3.4 Non-standard imports 

3.4.1 Attachments 

For the import of Attachments a premade import template is available at the Compano Help website: 

Template Import Attachments (CSV). 

 

Note: Attachments can be imported using any Import button. Also, this template will be imported without the 

need for an import layout. 

3.4.2 Conditions 

Purchasing conditions can be imported using either an ICC- or XML-file. Conditions can be imported using 

any Import button. 

 

For ICC-files, COS will check whether there is a purchase contract for the Supplier, that is still pending. If 

there is no pending contract, a new purchase contract will be created for that Supplier. 

 

For XML-files the Purchase contract number must be present as a field in the XML-file. 

3.5 Impact analysis 

All imports will generate a Log entry and an Import report. 

https://help.compano.nl/compano-manuals/manuals-l03.html#templates
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3.5.1 Import log entry 

A successful import will generate an import log record stating that the import is Finished: 

 

If the import terminated due to errors, you would see this listed in the logs as: cancelled: 

 

3.5.2 Import report 

This report will be sent via e-mail to the admin user of the Compano application. 

Other users can download the import report at System > Logs: 

 
The import report consists of two or more worksheets; a Summary and one or more worksheets listing 

Changed Records, Errors and/or Warnings: 
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3.5.2.1 Testrun 

Setting the Is testrun option to Yes on any import, will result in a simulated import; no changes are saved to 

the database, however you will receive an import analysis report listing any errors or warnings: 
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3.5.2.2 No changes on import 

When the import has finished without changing any data in COS, you will receive the following e-mail 

message: 

 

3.6 Import anywhere 

The import function automatically determines for which Entity the data is intended. This means that any 

Import button can be used to import any kind of data. If the system cannot determine the likely entity, the 

Import dialog will offer to select an Entity and Import lay-out for a correct import of the data file. 

 

Note: Depending upon the overview you selected for importing data, changes might not be immediately 

apparent. Either navigate to the ‘correct’ overview, or refresh the browser window (F5). 

3.7 Country-specific character sets 

When importing text files, the character encoding of the provided import file is used. The encoding is 

determined via a Byte order mark: https://en.wikipedia.org/wiki/Byte_order_mark. If this Byte order mark is 

missing in the import file, the default encoding will be used. This default encoding can be set at Company 

Settings. 

 

To change the fallback of encoding: 

 
1. Through the Menu go to My Details > Company settings: 

 
2. In the pop-up window, go to the tab International: 

https://en.wikipedia.org/wiki/Byte_order_mark
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3. Set the encoding to a different character set. 
4. Save the Company settings. 

 

The character encoding can thus be adjusted for companies in Germany (1252) or in the south of Europe 

(437). The Default encoding setting is: UTF-8. 

4 Layout management 

Layouts for import and export can be managed at System > Layouts. While the Export dialog allows for on-

the-fly generation of export layouts, these are limited to exports in Excel. However, the management option 

under the System menu allows for definition of export layouts in different formats. 

 

To manage a layout: 

 
1. Through the Menu, go to System > Layouts: 

 
2. Next, under Edit, select either Add Export or Add Import layout: 
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Important: A detailed explanation on creating export and/or import layouts is available in the Basic Manual 

Compano Online Software L03. 

4.1 Add export layout 

To add an export layout: 

 
1. Click on Add export layout: 

 
2. In the pop-up window, select the Entity15 for which you want to define the layout, for instance Item: 

 
15 An Entity is a data object in COS, for instance Product, Item, Assortment, Attachment, Price, etc. 
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3. Click on Add export layout. 
4. In the next pop-up window, fill out the options for the layout on the different tabs: 

 

Layout tab: 

 
a. Type: Choose the Export type: 

i. Excel export: Exports data in Microsoft XSLX-format. 

ii. Text export: Exports data in a Text format, such as CSV or Unicode. 

b. Name: Type a name for the Export layout 
c. Application: Choose whether the layout should be visible for only yourself (For me), for all 

users of this environment (Within the company), or for all members/users of all (layered) 
environments (For all members) 
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Properties tab: 

 
a. Insert header: Set to Yes if the export should contain a header line with data field labels 
b. Format: Selected either a Fixed width or Character separated format 
c. Separation character: Set the data field separation character. For CSV this is a semi-colon 

; and for Unicode use the code: TAB. 

d. Decimal separator character: Set the decimal separator character. The default setting for 
European CSV is a comma. 

e. Decimal group character: Set the date separator character. The default setting for 
European CSV is a point. 

f. Date separator character: Set the date separator character. The default setting for 
European CSV is a hyphen. 

g. Time separator character: Set the time separator character. The default setting for 
European CSV is colon. 

h. Text enclosure character: Set the decimal separator character. The default setting for 
European CSV are double quotes. 

 

Fields tab: 

 
a. Available fields: Add data fields to be exported from the list of available fields 
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b. Selected fields: Remove unwanted fields from the list of available fields. Note: The position 
number (Pos) indicates at which position (Excel data column) the value of the field will be 

exported. 
c. Properties: Optionally, set options for selected data fields. 

 
5. Click on Save record to save the layout. 

4.1.1 Add custom text-based export layout 

To create a custom text-based (CSV, Unicode) export layout: 

 
1. Through the Menu go to System > Layouts: 

 
2. Next, under Edit, click on Add export layout: 

 
3. In the pop-up window: 
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a. Export entity: Select the Entity for which the export layout needs to be created. Type the 

first few letters to searching for the correct entity. Note: If the language of your COS 
database is set to English, you will need to search for English entity names; for instance, 
Item instead of Artikel. 

4. Click on Add Export Layout to go to the next dialog window: 

 
Layout tab 

a. Type: Select the Text export type. 
b. Name: Type a name for the layout. 
c. Application: Decide whether the layout is for your own use only or for all users within your 

company which have access to your application. 
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Properties tab 

 
a. Insert header: Set to Yes to add a header line containing data field labels to your export. 
b. Format: Select Character-separated for CSV or Unicode files, or Fixed Width for a fixed-

width format. 
c. Separation character: Use a semi-colon for CSV or the code TAB for Unicode. 

d. Optionally, set the Decimal, Date, Time, and Text enclosure characters. 

 

Fields tab 
a. Select data fields from the Available fields and add them to the Selected fields: 

 
b. Properties (optional): Optionally, edit any properties for the data field, such as Header label, 

Text format, etc. 

 

Note: Properties may differ depending upon the type of data field. 

 
c. Conversion table (optional): Optionally, add a conversion table to convert the values of a 

field. See also paragraph 3.2.2 MULTI-PASS import 

A multi-pass import allows for multiple, consecutive imports of data with different import layouts. This method 

can be used for: 
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• Import of interdependent data sources, such as: 
o Product and Item 
o Item and multiple Attachments 
o Item with Current and Future Price 

• Import of column-based data sources, such as Items with different Packaging data, ordered in 
consecutive Excel columns. 

One Periodic Task instead of multiple, interdependent periodic tasks, for example, for importing product and 

item data. 

 

Important: A maximum of 5 consecutive imports can be handled this way. 

 

Note: Multi-pass imports can make use of Excel or CSV data files, provided the correct type of import layout 

is selected. 

 

For detailed instructions, see the Manual Periodic Tasks, which is available on the Compano Help website. 

 

Multi-pass imports need to be prepared and tested: 

 

First, set up and test the import of the main entity; for instance Product data. 

Next, set up and test the import of the subsequent data/entity; for instance Item data. 

Optionally, repeat this step for the remainder of the subsequent data/entity imports. 

Create the multi-pass import by linking the main and subsequent import(s). 

 

Example 

To set-up a multi-pass import, for example to import Product and related Item information: 

 

First, prepare the import layout for the main entity, which is Product data in this example. 

 

Note: Detailed information on how to add an import layout, can be found in paragraph 4.2 ADD IMPORT 

LAYOUT. 

 

Use the import layout and your data file to test the import; see PARAGRAPH 3.2 CUSTOM IMPORT for detailed 

instructions. 

Next, prepare the import layout for the subsequent data/entity, which is Item data in this example. 

Use the import layout and your data file to test the import; see PARAGRAPH 3.2 CUSTOM IMPORT for detailed 

instructions. 

Now, go to System > Layouts: 

 
Select the import layout of your main entity and, under Edit, click on Modify: 
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• In the pop-up window, on the Properties tab: 

•  
• Next import layout: Select the import lay-out for the subsequent data/entity import. 

• Save the record. 
d. Archive / Restore records 
e. The Archive Status of a record can also be changed using an import file. The import file 

should contain a data column labelled Archived, where the archive status can either be set 
to Yes (record is archived) or No (record is not archived): 

 
Archive products/items on import 

For the import of Products and Items only, an alternative archiving option is available: 

 

In the Import dialog the option Archive not imported records can be set to Yes. Any Products (or Items) 

which are present in the COS database, but are no longer offered as a record in the Import file (Excel or 

text-based), will then be archived. 

 



 

60 

 

Important: The Archive not imported records option will only be available when an Import layout is 

selected that contains the key data fields for the entities Product or Item. 

 

Note: Not imported records will only be archived when the import report contains no errors (!) 

 
Note: Archiving of products/items using the Archive not imported records will also function when the layout 

is used for a Periodic Import Task. 
f. Conversion . 

 
5. Click on Save record to save the layout. 

4.2 Add import layout 

To add an import layout: 

 

1. Click on + Import layout: 
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2. In the pop-up window, select the Entity16 for which you want to define the layout, for instance Item: 

 
3. Click on Add import layout. 
4. In the next pop-up window, fill out the options for the layout on the different tabs: 

 

Layout tab: 

 
a. Type: Choose the Import type: 

i. Excel import: Imports data from Microsoft XLS-format. 

ii. Text import: Imports data from a Text format, such as CSV or Unicode. 

b. Name: Type a name for the Import layout 
c. Application: Choose whether the layout should be visible for only yourself (For me), for all 

users of this environment (Within the company), or for all members/users of all (layered) 
environments (For all members). Note: this last option is only available for applications with 
multiple environments. 

 

Properties tab: 

 
16 An Entity is a data object in COS, for instance Product, Item, Assortment, Attachment, Price, etc. 
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a. Number of header rows: Set the number of header rows contained in your import file. Note: 

These rows will be skipped on import. 
b. Continue on errors: Set to Yes if the import should continue on errors in your data file. 

Errors will not be imported. Note: In combination with a test run import, this option will report 
all errors in a data file. 

c. Next import layout (optional): When opting for a multi-pass import, select the next import 
layout to be used with the import file. For more information, please see paragraph 3.2.2 

MULTI-PASS IMPORT. 
  



 

63 

 

Fields tab: 

 
a. Available fields: This column lists all data fields which are available in your application. Use 

the  button to add data fields for import to the Selected fields column. 
b. Selected fields: This column lists all data fields which will be used for import. 

 

Field position (Pos): This number indicates from which Excel data column the value of the 

field will be imported. Position numbers can be changed under Properties, by removing the 

check mark next to Automatic and typing a new number. Note: Position 1 corresponds to 

column A, position 2 to column B, and so on. 

 

Key data fields: When adding a new import layout, the key data fields for the selected entity 

will already be present in the Selected fields column. As these fields are mandatory, they 

should not be removed! Also see APPENDIX A: KEY DATA FIELDS PER ENTITY. 

 
c. Properties: Optionally, set import options per selected data field. 

 
5. Click on Save record to save the layout. 
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4.2.1 Adding translatable fields (multi-language license only) 

In a multilingual environment, (translatable) text fields in the field selector can only be added from the 

Product >Translations category17. From this category, you can select any of the languages available in your 

application and select the language-specific text fields that you need for your import layout: 

 

4.3 Finding layouts 

The Layouts overview lists all kinds of layouts, such as import, export, feed, import analysis, screen, report, 

etc. Use the Filter to easily single out a list of of only one type(s) of layout. 

 

For instance, to view all available Excel export layouts, set the Filter to: 

 
17 Note: In the field selector, these fields have been removed from the category Names and Descriptions. 
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4.4 Modifying layouts 

Existing layouts can be modified, using the Modify function: 

 
1. Select the layout to be modified in the Layout overview 
2. Under Edit, click on Modify: 

 
3. Adapt the layout and click on Save record. 

4.5 Copying layouts 

It is possible to copy shared layout with the Copy/Paste functions and then edit this local copy: 
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5 Appendix A: Key data fields per Entity 

This appendix list the key data fields for the most commonly used Entities, as well as any standard Excel 

import templates and corresponding import layouts which were premade by Compano. 

 

Note: Standard Excel import templates are available on the Compano Help website. 

 

When creating layouts, any mandatory key data field are marked in red font in the field selector. Also, these 

field are added to the Selected fields by default: 

 

When migrating from a previous version of Compano software, any existing import 
layouts might need adjusting, as mandatory key data fields could be missing. 

5.1 Product 

Mandatory fields Field selector category Remark 

Manufacturer code (gln) Manufacturer - 

Code Product > Codes - 

 

A ready-to-use template is available for importing (new) Products: Template New Products And Items 

(DICO/SALES005) - (XLSX). This template is available in 2 variants: 

 

• International: General version (1.1) for PIM International 

• Nederlands: Dutch version (2.3) for Dutch language-only PIM applications 

 

These Excel files can be imported using the corresponding standard import layouts:  

 

• Standard product import in Excel INT NL (v1.1) 

• Standaard product import in Excel (v2.3) 

 

For more information, see the Manual New Products, Articles, and Price Updates, available on the Compano 

Help-website. 

https://help.compano.nl/compano-manuals/manuals-l03.html#templates
https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
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5.2 Item 

Mandatory fields Field selector category Remark 

Supplier code Supplier - 

Item number Item > Codes - 

 

A ready-to-use template is available for importing (new) Items: Template New Products And Items 

(DICO/SALES005) - (XLSX). This template is available in 2 variants: 

 

• International: Template_New_Products_Items_PIM_International_r1-1_L04.xlsx 

• Dutch: Template_Nieuwe_Producten_Artikelen_PIM_Basis_r2-3_L03.xlsx 

 

These Excel files can be imported using the corresponding standard import layouts:  

 

• Standard artikel import in Excel INT NL - L04 (v1.1) 

• Standaard artikel import in Excel - L03 (v2.3) 

 

For more information, see the Manual New Products, Items, and Price Updates, available on the Compano 

Help-website. 

5.3 Price (update) information 

Mandatory fields Field selector category Remark 

Item supplier code Item - 

Item number Item - 

Sequence Price information > Numbers Value can be empty 

Price date Price information > Dates and 

time 

- 

 

For importing accessories, a ready-to-use template is available on the Compano Help website: 

 

• Template_Prijsupdates_PIM_Basis_r2-2_L03.xlsx 

 

Both Excel files can be imported using the standard import layout: 

 

• Standaard prijsupdates in Excel - L03 (v2.2) 

 

For more information, see the New Products, Articles, and Price Updates Guide, available on the Compano 

Help website. 

5.4 Certificate 

Mandatory fields Field selector category Remark 

Type Certificate > Other Value cannot be empty 

Number Certificate > Codes Value can be empty 

Sub number Certificate > Codes Value can be empty 

Issuer Certificate > Names and 

descriptions 

Value cannot be empty 

Start date Certificates > Dates and time In the Excel import file, the 

cells containing the Start dates 

need to be of cell type Date. 

 

https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
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Two templates are available for the import of Certificates: 

 

Adding new certificates: Template_Import_Certificaten_r1-0_L04.xlsx 

Linking certificates to products: Template_Link_Certificaten_aan_Producten_r1-0_L04.xlsx 

 

These templates can be imported with: 

 

• Standaard certificaat import - L03 (v1.0) 

• Standaard import product certificaat link - L04 (v1.0) 

 

For more information, see the Attachments and Certificates Manual, available on the Compano Help 

website. 

5.5 Product –Product relations 

Mandatory fields Field selector category Remark 

Manufacturer 1 (parent) Product relations > References  

Manufacturer 2 (child) Product relations > References  

Product code 1 (parent) Product relations > Codes  

Product code 2 (child) Product relations > Codes  

Sequence number Product relations > Numbers  

Type Product relations > Other  

Valid from Product relations > Time of day  

 

A ready-to-use template is available for importing product relationships: 

 

• Template_import_product_relaties_PIM_Basis_r1-1_L04.xlsx 

 

This template can be imported with the shared import layout: 

 

• Standaard product relaties import - L04 (v1.1) 

 

Note: This template is not suitable for importing optional products or optional items. 

5.6 Item –Item relations 

Mandatory fields Field selector category Remark 

Supplier 1 (parent) Item relations > References  

Supplier 2 (child) Item relations > References  

Item code 1 (parent) Item relations > Codes  

Item code 2 (child) Item relations > Codes  

Sequence number Item relations > Numbers  

Type Item relations > Other  

Valid from Item relations > Time of day  

 

A ready-to-use template is available for importing product relationships: 

 

• Template_import_artikel_relaties_PIM_Basis_r1-1_L04.xlsx 

 

This template can be imported with the shared import layout: 

 

• Standaard artikel relaties import - L04 (v1.1) 

https://help.compano.nl/compano-manuals/manuals-l.html
https://help.compano.nl/compano-manuals/manuals-l.html
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Note: This template is not suitable for importing optional products or optional items. 

5.7 Surcharges 

Mandatory fields Field selector category Remark 

Item supplier code Item - 

Item item number Item - 

Start date Surcharge > Dates and time - 

Type Surcharge > Other Not mandatory, but strongly 

recommended 

Optional fields Field selector category Remark 

Lower limit*  Need to be added to import 

layout as a ‘0’ field* 

Increment unit code*  Need to be added to import 

layout as a ‘0’ field* 

 

*) These fields need not  be present in your import file, however, they do need to be present in your import 

layout (possibly as an ‘0’ field). 

5.8 User-defined fields 

Mandatory fields Field selector category Remark 

Name Standard fields - 

Type Standard fields - 

Entity User-defined fields > Names 

and descriptions 

- 

5.9 LCA product data 

Mandatory fields Field selector category Remark 

Manufacturer code (GLN) Manufacturer - 

Product code Standard fields - 

LCA – declared unit code LCA declared unit - 

LCA – declared unit quality Product > numbers - 

LCA – Reference lifetime Product > numbers - 

LCA – Functional unit 

[language code] 

Product > Translations > 

[language code] 

Functional unit is a language-

specific text field; make sure to 

use different import for different 

languages. 

LCA – Third-party 

verification 

Product > Other - 

 

A ready-to-use template is available for importing LCA Product Data: 

 

• Template_Import_LCA-data_NL_r1-1.xlsx 

 

This template can be imported with the shared import layout: 

 



 

71 

 

• LCA data import NL (v1.1)18 

5.10 LCA declarations 

Mandatory fields Field selector category Remark 

Product manufacturer code Product  

Product productcode Product  

Stage LCA declaration > Other  

Indicator LCA declaration > Other  

GWP total LCA declaration > Numbers  

AP LCA declaration > Numbers  

EP, aquatic freshwater LCA declaration > Numbers  

EP, aquatic marine LCA declaration > Numbers  

EP, terrestrial LCA declaration > Numbers  

Pocp LCA declaration > Numbers  

ODP LCA declaration > Numbers  

ADPE LCA declaration > Numbers  

ADPF LCA declaration > Numbers  

WDP LCA declaration > Numbers  

PERT LCA declaration > Numbers  

Penrt LCA declaration > Numbers  

 

A ready-to-use template is available for importing LCA Product Data: 

 

• Template_Import_LCA-declarations_r1-1.xlsx 

 

This template can be imported with the shared import layout: 

 

• LCA declarations import (v1.1) 

 
  

 
18 Note: This import layout is language-specific (NL) and thus only valid for Functional Unit descriptions in Dutch 
(NL). Please change the field LCA – Functional unit to the for you appropriate language-specific variant. 
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6 Appendix B: ETIM classification version import 

By default, Compano PIM license offers classification of products using the ETIM Dynamic standard. 

Should you so desire, multi-classification of products—using different version of the ETIM standard—is 

available as an add-on license. Please contact sales@compano.com for more information and prices. 

 
To be able to classify in a different version ETIM, you will need to perform a one-off import of the 

classification system: 

 
1. Go to https://www.etim-international.com/downloads/  
2. Choose the version you need in the left-hand menu, for example ETIM7 

3. Download the corresponding IXF-file19, or example ETIM-7.0-ELECTRICALHVACS-IXF-METRIC-
EIDENL-NO-CHANGE-CODES-2017-09-01.zip (ETIM International DE/NL) 

 
 

4. In the Compano PIM environment, go to Menu > ETIM > Product Classes: 

 
19 From the ETIM International versions list, choose the METRIC system that corresponds best with your needs. In 
case need to fill-out both metric and imperial values, you will need to combine an ETIM-metric IXF-file with user-
defined fields and a proper set up of mapping UDF's to features. For more information, please check your Compano 
consultant. 

mailto:sales@compano.com
https://www.etim-international.com/downloads/
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5. Go to the Import/Export tab and click on ETIM classification import: 

 
6. In the pop-up window: 

 
a. Select: Select the ETIM IXF that you downloaded. 
b. ETIM-##: Click on the corresponding ETIM-button to import the IXF-file. In this example: 

ETIM7. 
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7 Appendix C: AutoImport/AutoCheck 

For industry standard data files, a different import method can be used: AutoImport/Autocheck. In 

combination with FTPS: 

 

Important: The data must be offered in one of the following industry formats: PAB, INSBOU, DICO/SALES, 

BMEcat or DQR (8 en 9). 

 

To setup AutoImport/AutoCheck: 

 
1. Upload your data file to the Compano FTPS server and place it in either the AutoCheck or 

AutoImport folder: 
i. AutoCheck: Data file is compared with current dataset on Artikelbeheer.nl; a report is drawn 

up and sent.  Note: After approval, the file must ALWAYS be manually placed in  the 

AutoImport folder  for actual processing, unless  the parameters.xml of the data file indicate 

the following: <PublishMethod>AutoAcceptStagingData</PublishMethod> 

ii. AutoImport: Data file is read and processed. A report is sent to the e-mail address indicated 

in  the parameters.xml of the data file. 

 
2. The data processing via FTPS is automated as a nightly job. 

This is only possible for the PAB, INSBOU and DICO/SALES data file types. A parameters.xml 
can be added to the BMEcat zip file  containing the following code: 
 
<?xml version="1.0" encoding="utf-8"?><UCProcessParameters 
xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns="http://www.2ba.nl"><<PublishMethod>AutoAcceptStagingData</Pub
lishMethod><ReportAllCheckDetailMessages>false</ReportAllCheckDetail
Messages><SendReportToEmail>mijn-
email@adres.com</SendReportToEmail><ReportLanguage 
/></UCProcessParameters> 
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